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Introduction

The UC Learning Center is the web-based Learning Management System (LMS) used across the University of
California for Systemwide training and development. Those who have direct reports identified in the UC
Learning Center will receive the Manager Role, in addition to the standard Learner Role. In some cases,
individuals may be given the Manager Role if they have been identified as needing access to manage the
training of those who are not their direct reports.

With the Manager Role, you can:

View training history and status of assigned training of direct reports or viewable users
View direct reports or viewable users current training schedule

Register direct reports or viewable users for activities

Assign activities to direct reports or viewable users
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Logging into the UC Learning Center

Log in at Ims.ucdavis.edu using your UC Davis Login (Kerberos).

UCDAVIS

UNIVERSITY OF CALIFORNIA

Central Authentication Service (CAS)
Username:

Passphrase:

Need Help?

Navigation

Homepage

When you first login to the UC Learning Center, you will see the homepage. Here you can launch activities you
are currently registered in, navigate to your training schedule or transcript, and use search features to locate
activities you wish to take. These will all be reflected on your own account. You can also get information about
your direct reports.

The Manager view is an enhanced version of the Learner view. For more information on Learner access, refer
to the Learner Guide.

My Learner Transcript &
Dashboard Certificates

Manage My
Registrations

Required Training

Find A Course How Do 1?7/ FAQ Contact Us

¢ Manage My Registrations: View your Training Schedule, where you can see both upcoming in-person
activities you have registered to attend, as well as any online activities you are currently in progress
with.

e Required Training: View a list of your required and recommended training where you can see details
about last completed, Expiration, and your assignment status.

e My Learner Dashboard: Access your required training and recently launched training

e Transcript & Certificates: View transcripts for any courses you have completed in the UC Learning
Center.
e Find a Course: Search for a course.
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e How To: Short YouTube instructional videos
e Support:
e UC Davis Campus:
= Contact UC Davis Staff Development and Professional Services at sdps@ucdavis.edu
for assistance with the UC Learning Center.
e UC Davis Health:
= Please open an incident ticket through ServiceNow or call (916) 734-HELP (4357) for
assistance with UC Learning Center.

Top Menu
Looking from left to right, you see the logo, which is clickable and redirects to the home page when clicked. Then
there are the Self and My Team, menus featuring dropdown menus for access to each selection's menu of items.

Learning
Center

f

Home

SELF ~ MY TEAM +~

=
Timeline
1)

Library

Learner
Dashboard E

There is a Menu Quick Find Search which allows quick access to linked pages within your user account, including
assistance with navigation within the LMS. If you select Navigation and type a keyword, the search reveals directly to
the “keyword” objects.

Learning

Navigation

Reports
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Example: First, select Navigation, next enter “Users” in the search field, then click enter, and you can navigate
directly to the associated pages.

Bmm Learning Navigati .
Center avigation

Learning

Navigation

Reports { NAVIGATION ~ users Q }

Timeline

ii‘ 2 of 2 results for "users” Sort By: Best Match ~

Library

-
H Dashboards
Learner

Dashboard Displays default home Dashboard page of user.
Self/Dashboards NAVIGATE

Used to access exception report information for managed users and direct reports.

NAVIGATE

[ |
Manager Dashboard
[ |

My Team/Manager Dashboard

Using the Manager Tools

Once you have been identified as the manager of a user in the UC Learning Center,
you will automatically have the My Team appear in the Top Menu. This will giveyou
access to a Manager Dashboard.

MY TRFAM

Self: View your Profile, Learner
Dashboard, Training Schedule
and Advanced Reporting

Dashboards

Learner Dashboard

Learning

My Team: Access your

Development
manager dashboard Manager Dashboard

Reporting
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Manager Dashboard
When you navigate to your Manager Dashboard, you will be able to see:

e A snapshot of your current exception report, which shows the overall status of your managed users’
assigned training.
o Alist of your managed users with the status of their individual assigned training.

[ o ] Pending Approvals

[ B Ul R - LEARNING ACTIVITIES

¥ EXCEPTION REPORTS

PN

R (135)

= Print

Last updated: 7/25/2021-3:31 AM PDT

None
32)
(130)
/ (128)
)
v
Direct Reports DirectReports + Others
W Not Completed M Completed
USERS (60812)  ACTIVITIES ‘ User search... ||z|
™= Print X Export ‘ All Viewable Users v | Sort by: ~fy
~
) 5 ] i
null@sumtotalsystems.com null@sumtotalsystems.com
User Number: 2 User Number: 2 E
Required: 0 Required: 0
Recommended: 0 Recommended: 0
(0% | v

Manager Dashboard is updated nightly, so if one of your users completed training after the latest update, it will
not appear in this view until the next update. However, the user’s training transcript and schedule are
displayed in real time and will show you their latest status.

View Managed Users
In the Manager Role, you have the ability to view information about your managed users and the progress of
their assigned activities.

Your viewable users will all be displayed in tiles on your Manager Dashboard. You can scroll through these
tiles to locate a particular individual or you can search the user by name, or sort in ascending or descending
order (by name, assignment progress, etc).

You will automatically see all users you have been given access to view, either as your direct reports or as
managed users whose training you are responsible for managing. If you manage more users than just direct
reports, you can change your view from All Viewable Users to Direct Reports if you wish to only view your
direct reports.

HRTalentManagement Manager/ Reporting Guide | 4



v EXCEPTION REPORTS

No tasks data to be shown.

Past Due Training A

No past due training information

USERS (4)

# Print

ailable

ACTIVITIES

X Export

Last updated: 12/9/2020-3:04 AM PST

‘ User Search...

J(a]

Display |

Learning Activities

View Status of Assigned Training
When you first enter your Manager Dashboard you will see an overview of your managed users and the
status of their assigned training. The Exception Report at the top will show you the percentage of compliance
your managed users are currently at for all training assigned to your managed users. For each individual, you
will see the overall status of their currently assigned training. Click the blue INCOMPLETE button to see a
more detailed report. Remember, you can also sort this list by process.

~ EXCEPTION REPORTS

( B

Print x Export
= P

‘ All Viewable Users v | Sol

All Viewable Users

kby: "

User Number:
Required: 3
Recommended: 0

PROFILE

3 INCOMPLETE

User Number: [
Required: 1

Recommended: 0

PROFILE

96%

1 INCOMPLETE

Assigned Training by Activity

Lsst updated

| User Search...

Direct Reports

You can also see which trainings are assigned to your managed users and the overall completion of the

training.

Switch from the Users view Activities view to see all the activities that are currently assigned to your
managed users. You will now see how many are still required to complete each training and the overall

percentage of completion.

HRTalentManagement
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Last updated: 12/9/2020-3:04 AM PST

‘ Activity Search... ‘ Q

# Print X Export All Viewable Users |V | Sortby: *@3
~
eCourse DAC-CANRA < eCourse DAC-AFSCASH eCourse DAC-AFSCASHNET
::‘. CANRA Training for Mandated '\a Cash Handling .‘:‘. CASHNet Deposit Training
Reporters » L
A\ /4 A\ /4
Required: 0 Required: 0 Required: 0
Recommended: 0 Recommended: 0 Recommended: 0
100% 100% 100%
0 USERS 0 USERS 0 USERS
eCourse CLERY-DA-ECO = = eCourse DAC-AFS-CREDIT ‘ ILT Course DACH-HRS109-D...
.l=‘. Clery Act Training for Campus Credit Card Handling Employment Law and Liability
Security Authorities (CSAs)
L\/4 _J_l_l y
Click on the blue Users button to see who is still required to complete the training.
cdavis.edu
User Number:
Lo Required: 3
Individual Reports Recommended: o
To view a detailed report for an individual user:

1. Locate the user you wish to find out more information about.
2. Click on the blue Incomplete button.

This will show you an overview of the user’s assigned training, including a list of all training that has been
assigned, the due date for each training, and their overall progress in completing all assigned training.

DETAILED EXCE

PTION REPORT BY USER

Overall progress

Q 7~'v Last Processed: Wednesday December 9, 2
Neer by ) O Refresh 4 Asd & primt 2 Expont
iuiad a Progress ™
1 eq ez 4 [ 0% |
4| B3
1. Clicking the Title of the course will show you more information about the training.
2. Using the menu bar on the left side, you can filter the training to show only what assignments are
Overdue or what has been Completed.
3. You will see when the information was Last Processed in the top right corner.
4. Clicking the Close button will take you back to the Manager

Dashboard.

HRTalentManagement
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Training Analysis
Another way to view a user’s assigned training is to go to that user’s Training Analysis page.

Username: |
Required: 0
Recommend °

Self-Reported Training

Training Ang:
PROFILE

Training Schedule

fraining Transcript

1. Locate the user you wish to find out more information about in your
list of direct reports or viewable users.

2. Click the drop-down arrow next to the white PROFILE button.

Click Training Analysis.

4. This will launch Emulation mode which allows you to view Learning details about your managed
users. You know you are in emulation mode by the orange banner across the top menu bar stating
“You are emulating 's account.” The “Self” now applies to the user account you are viewing.

w

(To exit Emulation mode, click BUTEMULATION X it Emulation)

5. The page provides an overview of the user’s currently assigned training, the due date for each training,
and current assignment status. Click the View drop down menu to see additional information.

e

ﬁ You are emulating Z I's account. To end emulation mode, click Exit Emulaffs EXIT EMULATION X

i TRAINING ANALYSIS

[T1Y This is a list of your required and recommended training. Use the View list to filter the activities that you see below.

Search: Help Filter by: View:

Required and recommended ~ | All assigned training ~

- X
[ selected Items: 0 | Records: 1
Name . Code Priority Assigned Date Due Date Last Completed Date Expiration date i Type
Status
@ eCourse:UC Laboratory Safety Fundamentals Refresher DAC-UCLSFRE- 9/23/2019 9/23/2022 9/24/2019 9/23/2022 Required Acquired
Certification UCLOLO019-ECO

Delivery Method Legend
While in Emulation Mode, you can view the following training information for the user:
View:

All assigned training v

All assigned training

Training assigned by job

Training assigned by organization
Training assigned directhy

Training certifications

Assigned training requiring registration
Completed assigned training

Certifications history
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View Training Schedule
You can view a managed user’s training schedule to see their current registrations and progress.

1. Locate the individual you wish to view.
2. Click the drop-down arrow next to the PROFILE button and select Training Schedule.

Username:
Required: 0
Recommend

Self-Reported Training

Training Analysis
PROFILE | | 0 INCOMPLETE
Training Schedule

Training Transcript

3. This will launch the Emulation Mode, which allows you to view Learning details about your managed
users. You know you are in emulation mode by the orange banner across the top below the menu
4. Now you can see that user’s registrations and other canceled, in progress or completed training.

You are emulating [ )'s account. To end emulation mode, click Exit Emulation. EXIT EMULATION X

TRAINING SCHEDULE

This is a list of current training activities for which you are registered.

20 (=]

CURRENT/UPCOMING EXPRESSED INTEREST PENDING SIGNATURES COMPLETED CANCELED WAITING LIST OR PENDING APPROVAL LEARNER ATTACHMENTS

Timedine

=
1 |
Learnar

Dashboard ALL ONGOING ACTIVITIES UPCOMING ACTIVITIES FIXED DURATION ACTIVITIES COMPLETION REQUESTED ACTIVITIES

Displaying 1 of 1 Records 10 25 50 100
[£) Export To Excel & Print | Cancel Registration [T) View Calendar
O Activity Name * Status Code = Region ¥ Start Date > End Date = Actions
| viol d | SWSAST-DA-ECO-UC
D e e e Sunor e [ oprions - |
eCourse
Certification
Training Transcript
To view all completed training for a managed user, you can view their ‘ ‘
training transcript. Ussrnarme: 1726532
Required: 0
1. Locate the user you wish to find out more information about using RO el Reported Training
i [=—————i]] =
the User Search function. seorns ] TG Analyss =3
2. Click the drop-down arrow next to the white PROFILE button
3. Click Training Transcript. Training Transcript

4. This will launch Emulation mode, which allows you to view

Learning details about your managed users. You know you are in emulation mode by the orange
banner under top menu bar.

5. You will be taken directly to that user’s transcript. Select the timeframe you wish to review using the
year or date range filters. Note the default view is for one year.

You can view the transcript or individual certificates of completion and export them to PDF.

HRTalentManagement Manager/ Reporting Guide | 8



To export the training transcript to PDF:

1. Click Export to PDF in the top right corner.
2. Click the link to download the PDF SumTotal
3. The PDF will open in a new window.

Click here to download the filg

To export individual certificates to PDF: o |

1. Click the certificate logo next to the course name.
2. Click Export to PDF and follow the steps above.

ACTIVITIES

Activity Estimated Credit  Start Date Completion Date « Expiration Date Score Grade Attended Code
Hours Duration

Q‘{ eCourse y 12/22/2016 12/22/2016 12/22/2017 Days: 0, Hours: SECURITY-RE-OP-ECO

Register Users

A manager can register their managed users for courses. It is recommended to register users for in-person
training and assign online training. To register managed users:

1. Locate the activity you wish to register by using either the Catalog or Search function.
2. Click the Ellipsis (More Options) to the right of the course title and select Register Others.

# / Search
‘ LEARNING ~ construction safety orientation Q ‘
Filter Results Clear all 20 of 138 results for "construction safety orientation” Sort By: Best M M =]
ore
Actions
Saved Searches >
ECOURSE
Activity Type v P/ N Construction Safety Orientation :
D : (1 ] ] This course is designed to inform new construction workers and site visitors in and around CoNS MU oo |
. EERER(UD) W\ /4 Il DACU-esh_sah_a84 sh_enus-UCSKSS0022-ECO-SAFSVC
ILT Course (25) . .
7 LERN 7Yy vy o) O View Details
[ class 2)
ECOURSE Add To Development Plan
Duration (Minutes) 2 “‘ VMTH LAC Safety and Orientation Maﬂage Assignments
. VMTH Large Animal Clinic Safety and Orientation Training. You must view all slides for completion. R
T - ] ] 8 :
P W\ /4 Il DACVMTH-LAC-SAFETY _Register Others
Language > e <
Activity Availability > ECOURSE
Start Date > P/ 1 Indoor Hoisting and Rigging
([ ] ] This course is designed to educate the worker on the significant safety issues to be considered while moving large, heavy loads ass...
Location > b\ /4 Il DACU-esh_sah_a60_sh_enus-UCSKSS0088-ECO-SAFSVC

3. Ifthis is an online course, click Continue to add users. If this is an in-person training, you will need
to select the offering you wish them to attend first before you can click Continue.

HRTalentManagement Manager/ Reporting Guide | 9



Select Activities

.g|

Available Capacity: Unlimited

@ eCourse: Construction Safety Orientation

Available Capacity: Unlimited

CONTINUE

Select Users

®

CAMNCEL SUBMIT RESET

4. Click Add under Available Users to locate the users you wish to register.

You can select multiple users and register them all simultaneously for an activity. First, select the activity or activity structure and click Continue. Then add users to your available list. From this list, select users to send to the
roster or the waiting list. When you are done, click Submit to process the batch of users or If payment is required, click Purchase

BIOSAFETY: BLOODBORNE PATHOGE...
Select Activities
Available Capacity: Uniimited

@  eCourse : Biosafety: Bloodborne Pathogens Training and Annual Refresher

Select Users

AVAILABLE USERS

Available seats
Selected users: 0
Available users: 0

Available Capacity: Unimited

Skip registering users to activities that have not to the overall
of the activity structure

REGISTRATION

Records: 0
Available seats: Unlimited
Users pending approval: 0

Users not in allocation: 0

Remove All

"F“AH e
v

There are several options to narrow down the users you wish to add. As Manager, the only option that
will be relevant is Select Viewable Users.

5.

Learning
o]
Center

SumTotal
O Select users by arganization
O Select users by job
O Select users by manager
O Select users who require the activity
Select viewable users

O Select users by e-mail, user number, username, or NT account (sop by commas or

CANCEL NEXT A

6. Click Next. You now have the option to:

e Type a user’s name in the search box and click the @button.
e Browse the list of users for individuals you wish to register.

o Click Select All at the bottom of the page to select all active users or select the top box to select
all users on the current page.

HRTalentManagement Manager/ Reporting Guide | 10



7. Select the check box next to the user(s) hame you wish to register. Click OK at the bottom to
continue.

m Learning
Center
SumTotal

SELECT USERS

Select one or more users from the list below and click OK.

Search: Help

@

Y selected Items: 2 | Records: 9

E-mail Address Manager Primary Domain Primary Job Primary Status
Organization

noreply@sumtotalsys... KIM M. AYOUB UCSD VC CHIEF 7664 - PERSONNEL HUMAN RESOURCES
FINAN AN DEPT

noreply@sumtotalsys... KIM M, AYOUB UCSD VC CHIEF 7664 - PERSONNEL HUMAN RESOURCES
FINAN, AN DEPY

noreply@sumtotalsys... KIM M. AYOUB UCSD VC CHIEF 4723 - BULANKAST2  HUMAN RESOURCES
FINAN. DEPY

noreply@sumtotalsys.. KIM M. AYOUB UCSD VC CHIEF 7664 - PERSONNEL HUMAN RESOURCES A

Learning
Center

d to the overall

Skip registering users to activities that have not
of the activity structure

AVAILABLE USERS REGISTRATION
Available seats Records: 0
Selected users: 2 Available seats: Unlimited
Available users: 2 Users pending approval: 0
Users not in allocation: 0
Remove All
Add Select All  Clear All
Name «
Name « Status
M No issues WAITING LIST
Records: 0
& BR No issues

Remove All

Name -

CANCEL suBMIT m A

9. Click Submit once you have selected the users to be moved over.
10. The users are now registered for the activity.

Note: If the activity is in-person they will receive an email notification of their registration. If the activity is online
there is no registration notification, so you may want to inform them they need to complete the training.
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Manage Assignments

A manager can assign their managed users for courses. Manager assignments are recommended for
individual assignments only. To assign managed users:

1. Locate the activity you wish to register by using the Search function.
Note: Be sure to select the correct search action “Learning” to look up

Learning =

Learning

Learning Activities.

Navigation

Reports

2. Click the Ellipsis (More Options) to the right of the course title and select Manage Assignments.

ECOURSE

P/ 1Y SHCS Hand Hygiene (2019-20) => :

1 ] | Hand hygiene training for Student Health and Counseling Services
A\ /4 ll DAC-SHCS-HAND-2018-20

(14) View Details
ECOURSE Add To Development Plan
P/ \ N SHCS Transmission-Based Precautions: Airborne (2019-20) Manage Assignments
1 ] | Transmission-based precautions (airborne) for Student Health and Counseling Services. .
W\ /4 Il DAC-SHCS-AIRBORNE-2018-20 Register Others
wwE D

3. Toadd a new assignment, click Add.

MANAGE USER ASSIGNMENTS FOR sHcs Hand Hygiene (2019-20)

List of users assigned to this activity.

Last Processed: Sunday, July 25, 2021 3:31:08 AM PDT | Current Assignments ~

Add ™ Print X Export
Direct Reports v . . .
You either do not have any direct reports or none of your direct
Direct Reports reports are currently assigned to this activity.

|AII Viewable Users |

EDIT REMOVE

P Assignment
P Assignment Type

¥ Assignment By
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4. Select the user(s) you wish to assign the activity to (Note: You may need to click All Viewable Users if
you do not have Direct Reports) and click Next.

Manage Assignments

SELECT USERS

)
Select elther one or all users to set assignment options.

Search @

. User Number Primary Job Manage
Direct Reports
All Viewable Users &K | CV)OB

W am 1970431 0520 - SYS ADM 4 RICHARC

5. Setthe Type (Required or Recommended) and choose a Start Date

Manage Assignments

EDIT ASSIGNMENTS FOR Hand Hygiene

Select either one or all users to set assignment options.

Assignment Options:
Select: All | None

Selected users (1)
Type:
N N

@ Required
Type:Recommended | Status:Assigned Or -
Due Date:No Due Date /Recommende:

+ Sort by: Name v

[Clignore Previous Completions

v
Start Date:
® Today
O Days from today
Oon
Time zone:
uTC v
Priority:
None [V
6. Scroll down to set the Due Date and click Apply to Selection, then click Done.
Due Date:
OMNo Due Date
®within | 30 Days
Oy El
Time zone:
uTc

Assignment Notes:

Status:

Assigned |v

’ APPLY TO SELECTION |

o] (] (D
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7. Under the Manage Assignments screen, you can Edit or Remove the assignment.

Manage Assignments

MANAGE USER ASSIGNMENTS FOR Hand Hygiene

List of users assigned to this activity.

(@]

Last Processed: Wednesday, June 21, 2017 9:32:52 PM PDT | Current Assignments |v

Refresh Add ™ Print X Export

All Viewable Users ¥

[0 Name -~ User Number Assignment Date Due date Priority Type
Show all assignments
2
@) On 1 6/21/2017 7/22/2017 Require
Filter by: [ AN 2/24/2016 - Recomn
> Assignment Status

Records 1-2 of 2 Page 1 of 1

> Assignment Typge

EDIT REMOVE

Check the box next to the activity you wish to edit or remove, then click the EDIT or REMOVE
button below the activity list.

Note: Users should receive an assignment notification later that night. If you need to assign
training to staff based on job code / department and want to include transfers/new hires in the

future, please contact the appropriate training group of the activity to setup an Audience to
make the assignment.

Advanced Reporting - Campus

In preparing reports, supervisors can confirm their employees’ training status in a few ways. The
easiest is to run an “UCD Campus Assigned Training Status Report” through their Advanced
Reporting dashboard in the UC Learning Center (http://Ims.ucdavis.edu). There are several report
templates in the UCD Campus Folder to choose from.

1. Click the Self menu (upper left-hand corner of screen), click Reporting, and then click
AdvancedReporting.

HRTalentManagement Manager/ Reporting Guide | 14
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SELF - MY TEAM v

Dashboards > Advanced Reporting

Learner Dashboard Training Transcript

Learning
Development

Reporting
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2. Your screen should now display the Advanced Reporting dashboard:

B o sar v worow

Libra View -
L 2} ry

Home

© Folders Repository
=7 » B= UC_PROD

Timeline

[}

Library

(=) Name Description

=
—1 |
Learmer
Dashboard

3. Expand the folder list on the left-hand side of your screen to reach the UCD Campus
folder:

UC_PROD > Custom > Reports > UC Locations > UCD > UCD Campus

Library  View -

* Folders Repository
~ @ UC_PROD Run Copy
» @ Custom ® Name Description

~ mm Reports

ePerformance Compliance Training Status—General (Et... Reports on all individuals' general compliance (=thics), cyber security and sexual haras...

+ @ UC Locations

UC Cyber Security Training Status Report Reports individuals who are either overdue or coming due for UC Cyber Security Funda...

-—
v mm UCD UC General Compliance (Ethics and Conflict of Interest)... Reports individuals who are either overdue or are coming due within the next 60 days f..
4 UCD Campus UC Learning Center Course Attendance Report Reports trainings attended/completed for all viewable users. Can be filtered by time pe...

=
» W UCD Health UC Sexual Harassment Prevention Training Status Report Reports individuals who are sither sverdue or coming due in the naxt 60 days for saxu.

UCD Campus Assigned Training Status Report Reports status of required trainings for all viewable users. Can be filtered. See LMS Ad..

UCD Campus Return To Campus Training Status Report  Reports on assignment status for Return to Campus training.

4. Click the name of the report you wish to run

UCD Campus Assigned Training Status Report Shows all individuals’ assigned training
status. This guide uses ePerformance Compliance Training Status—Cyber and Sexual
Harassment Prevention Report as an example.

5. Once your report appears, you can export it or Sort/Filter within the LMS report by
clicking on the column title

HRTalentManagement Manager/ Reporting Guide | 16



To Export:
Click the export icon and choose the desired format (e.g. Excel).

O ePerformance Compliance Training Status--General (Ethics), Cyber and Sexual Harassment Prevention  paarefesnes2021001200132007 @

Back - =) - 4 100% + Q|-
PDF
—_— . UC General Compliance, UC Cyber Security and UC Sexual Harassment Prevention Training Status--All Employees
xcel (Pa
i Current
Name Email Position Department Supervisor Name Course Requirement Next Due
Satisfied?
csv . STUDENT HOUSING = 4321
DOCX Hous! es a2
RTF fes 20821
oot s
oDs

XLSX (Paginated)
XLSX

PPTX

HSDE

ASALUS, AMERIA L -

ERIZATIONLAB  weunvusuiy. raucr

CARDIAC CATHE

To Sort/Filter within the LMS Report:

When you run the report, it will provide all data. Click on the Course Name or Course Code, or any other
column title to bring up sort/filter options:

Library  View . Create +

D ePerformance Compliance Training Status--General (Ethics), Cyber and Sexual Harassment Prevention
Back B. B. =

Data refreshed 20210112 at13:2007 ()

- <4 |100% |~

UC General Compliance, UC Cyber Security and UC Sexual Harassment Prevention Training Status--All Employees T e -

Current e
Name Email Position Department Supervisor Name Course Requirement : Next Due
Satisfied?
004 STUDENT HOUSING S s

undamentals es
004026 wal Harassment

000462

000483 -

Click the Filter icon to bring up filter options - This example uses the “Course” column as the filter subject

T

* tus-—-All Employees

Course

UC Cyber Security Awareness Fundamentals

UC Sexual Violence and Sexual Harassment
Prewvention Training for Mon-Supervisors

UC Cyber Security Awareness Fundamentals

UC General Compliance Briefing: Universit
California Ethical Values and Conduct

UC Sexual Violence and Sexual Harassment
Prewvention Training for Mon-Supervisors

UC Cyber Security Awareness Fundamentals

UC General Compliance Briefing: University of
California Ethical Values and Conduct

UC Sexual Violence and Sexual Harassment
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After you click the filter icon you can click “Show only rows where” you may either use “Equals” or “Contains”
and use your appropriate title in place of UC Cyber Security (or, you may use a date, etc)

Filter column: Course
() Show all rows

@ Show only rows where

Contains w UC Cyber Security

Cancel

If you wish to filter before you export to excel, you can hover over the export Icon, and then as XLSX

(Once you have exported to Excel, you can sort and filter by course name or date, or even last name to see all
completions for your supervised employees)

Return to Report List
If you would like to run other reports, select View > Repository to return to the report list.

Library  View -

O ePel  SearchResults liance Training Status--General (Ethics), Cyber an
NN Feosioy (PSR
Schedules

Reports you can run include:

e ePerformance Compliance Training Status—Cyber and Sexual Harassment Prevention
Shows all individuals’ cyber security awareness and sexual harassment prevention
status training status. (Best for identifying mandatory training compliance for
Pay4Performance program.)

e UC Cyber Security (Initial and Refresher) Training Status Report
Shows individuals who are either overdue or coming due for cyber security awareness training.

e UC Learning Center Course Attendance Report
Use this report if you would like to view all training completed by your employees. (Can be
filtered to only display trainings completed during a given time period.)

e UC Sexual Harassment Prevention Training Status Report
Shows individuals who are either overdue or coming due for sexual harassment/sexual
violence prevention training.

e UCD Campus Assigned Training Status Report
Use this report to view the status of all training assigned to your employees.
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Exit Advanced Reporting
Either click the “University of California Learning Center” logo in the top left corner of your page
or you can click the HOME icon to returnto your UC Learning Center homepage:

Learning
[OF
Center

Advanced Reporting - Health

1. Click the Self menu then click Reporting, and then click AdvancedReporting.

SELF ~ MY TEAM ~ ADMINISTRATION

Dashboards » Advanced Reporting

Learner Dashboard Training Transoript

Learming
Development

Reporting
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2. Your screen should now display the Advanced Reporting dashboard:

- = |\

Library View

£ Folders

UC_PROD

Name Description

For Health
Expand the folder list on the left-hand side of your screen to reach the UCDH folder:

UC_PROD > Custom > Reports > UC Locations > UCD > UCD Health

Library  View +

© Folders Repository
v B UC_PROD Run Copy
v Bl Custom ® Name Description Type
| =
v mm Reports Activity Attendance (Real-time) Report Report
— .
~ mm |UCLocations Activity Attendance Report Report
~ il UCD
L Assigned Activity (Real-time) Report Report
| ™
» mm UCD Campus Assigned Activity Matrix Report Report
¥ = UCD Health Assigned Activity Numbers by Activity Re... Report
Assigned Activity Numbers by Org Report Report
Assigned Activity Report Report
Registration Status Report Report
User Report Report
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Execute Report
Click the report you wish to run

G} Name De:

Activity Attendance (Real-time) Report

Activity Attendance Report

Assigned Activity (Real-time) Report
Assigned Activity Matrix Report

Assigned Activity Numbers by Activity Re...
Assigned Activity Numbers by Org Report
Assigned Activity Report

Registration Status Report

User Report

Once report appears, you can export it or Sort/Filter within the LMS report (before exporting)
To sort/filter within the LMS Report:

Once you run the report, it will provide all data. Left click on the Course Name or Course Code, or any column
titte/heading to bring up sort/filter options:

n " ‘1"'[u5--ﬁll Employees 7

Course

Options
Narrow your results by applying a filter from the Options menu
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(© Activity Attendance (Real}nn{) RepOrt  atarefreshed 2001130013003

Back E. B. ‘ = ’ — <+ [100% |v || [searchreport Q[+

Activity Name Activity Code Full Name User Name Completion Status Start Date End Date
gfofk lﬁ_\‘*g’:‘ X DAHS-CTSC-IRB-1 Jan 13. 2021
‘éf, eL;boramry Bé\ﬁgﬁb?ms. Skdan0.202 Jan 13, 2021
e T
e W
UC Laboratory DAC-UCLS 4] Jan 13, 2021
Safety Refresher UCLOLOO1! Activity Code contains

UC Laboratory DAC-UCLS b Jan 13, 2021
Safety Refresher UCLOLO01 :
o DAHS-NSCH End Date is on or after 4 Jan3t, 2021
g:fui:t‘zsg‘zﬁ DAHS-NSCH DAY ) 4 Jan 31, 2021
r:q::dcﬁ[:;zsomzﬁ DAHS-NSCH 4 Jan 31, 2021
Nomsashs oasswsd R e
g:;iksx:xzsé;ﬁ DAHS-NSCH 4 Jan 31, 2021
Nomsactr  owiswed PR
g:zzk &“:x:l!zss;p‘ DAHS-NSCH 4 Jan 31, 2021
g:emui;axf&ﬁ DAHS-NSCH 4 Jan 31,2021
NemSatie  owiswsg j e
Nomsatr  owiswed P
NomSasre | owiswed g =1 = B | |wivan
Nova StatStrip i e A TR TR R RS T TR TR TR R RS TSR R TR TTT——T ¢ me s

To Export:
Click the export icon and choose the desired format (e.g. Excel).

Back ﬂ ,@ =
PD

F

) rity Hame Activity Code
Excel (Paginated)
j1-0 How to DAHS-CTSC-IRE-1
Excel : with the IRB
aboratory DAC-UCLSFRE-
y Refresher UCLOLO018-ECO-v1
csv aboratory DAC-UCLSFRE-
y Refresher UCLOLO018-ECO-vw1
DOCY aboratory DAC-UCLSFRE-
iy Refresher UCLOLOD8-BECO-v1
RTE aboratory DAC-UCLSFRE-
y Refresher UCLOLOD18-ECO-vw1
aboratory DAC-UCLSFRE-
ooT w Asfrezher UCLOLO02-ECOv1
oDs ﬁ‘;tféz'ﬁ DAHS-NSCNOVAZ1-FOCT
| StatSirip - —
XLSX (Paginated) iist 2021 DAHS-NSCNOVAZ1-POC
ﬁ‘;‘f‘ézﬁ DAHE-NSCNOWA21-POCT
- | 5 -
ﬁt:tizsé;ﬁ DAHS-NSCHMOVAZ1-POCT
PPTX :
ﬁ‘;t‘zséz'ﬁ DAHS-NSCNOVAZ1-FOCT
HSDE ﬁzﬂ;ﬁ DAHS-NSCNOVAZ1-POCT
"Nova StatStrio e e

(Once you have exported to Excel, you can sort and filter by course name or date, or even last name to see all
completions for your supervised employees)
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Return to report list

If you would like to run other reports, select View > Repository to return to the report list.

Library View -

O Actir  Search Results Real-time) Report  oaarefreshed 20010113 2013:030 (2

S oo S

Schedules
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Contacts

UC Davis Campus:

e Learning and Development
sdps@ucdavis.edu
530-752-1766

UC Davis Health:

e Learning & Development
HS-T-D@ucdavis.edu
916-734-2676

e Center for Professional Practice of Nursing
hs-cppn@ucdavis.edu
916-734-9790

¢ Information Technology Education
hs-itedu@ucdavis.edu

o Help Desk
916-734-HELP (4357)
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